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Product Summary

This release bulletin provides late-breaking information about PowerBuilder® 12.5.2.

Sybase® PowerBuilder version 12.5.2 supports these operating systems:

• Microsoft Windows XP with Service Pack 3
• Microsoft Windows Vista Business Edition 32-bit and 64-bit with Service Pack 2
• Microsoft Windows 7 Professional 32-bit and 64-bit with Service Pack 1
• Microsoft Windows Server 2008 32-bit and 64-bit with Service Pack 2 (runtime only)

For information about accessibility, see Accessibility Features in this release bulletin.

Product Summary
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Changed Functionality in This Version

There is one change in this release.

Web Forms Target Removed
Web Forms targets are not included in this release of PowerBuilder.

Customers using Web Forms in PowerBuilder 12.5.1 or earlier should not install the 12.5.2
GA. The EBFs for 12.5.2 will include fixes for Web Forms as well as issues for other features.

Changed Functionality in This Version
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Known Issues

Learn about known issues and workarounds.

Note: You can search the Sybase Web site for solved cases. Choose Support > Solved Cases
or go to http://search.sybase.com/search/simple.do?mode=sc. You need a MySybase account
to view solved cases in the archive.

Known Issues for Databases
Learn about known database issues in PowerBuilder.

Table 1. Database Issues

CR# Description

634719 Informix database connections in PowerBuilder do not support Win-
dows 64-bit systems except for Windows 2008 R2 64-bit systems.

See the Informix Client SDK system requirements at https://
www-304.ibm.com/support/docview.wss?uid=swg27016673. For Infor-
mix ADO.NET connections on Windows 2008 R2 64-bit system, you must
install both the 32-bit and 64-bit database drivers from Informix.

Known Issues for the WPF Window and Menu Painters
Learn about known issues and apply workarounds for the WPF Window and Menu painters in
PowerBuilder .NET.

Table 2. WPF Window and Menu Painter Issues

CR# Description

698145 Error occurs when previewing a window that includes a Visual Object
with a namespace.

The error reads: Illegal data type: xxx.u_xxx. Com-
pile for preview returned = 3. Unable to pre-
view.

618528 Menu items that use special symbols in their names cannot be deleted.

In PowerBuilder .NET, you cannot delete menus that include symbols, such
as "@," "#,""$," and so on, in their names.

Known Issues

Release Bulletin 5

http://search.sybase.com/search/simple.do?mode=sc
https://www-304.ibm.com/support/docview.wss?uid=swg27016673
https://www-304.ibm.com/support/docview.wss?uid=swg27016673


CR# Description

612182 PowerBuilder .NET does not properly support the Properties window
Events tab.

Not all events are listed on this tab, and if you show an object's events in the
Properties window, then double-click an event, or click in the drop-down
list next to one of the listed events, an error message indicates the event
handler is invalid.

Known Issues for the WPF DataWindow
Learn about known issues and apply workarounds for the WPF DataWindow® in
PowerBuilder .NET.

Table 3. WPF DataWindow Issues

CR# Description

675761 Select symbol display issue.

In a .NET Assembly target's PrintDW at runtime, the select symbol does not
appear for RadioButton or CheckBox controls.

675595 DW.Print to a physical printer does not work when print.filename is
empty.

If print.filename is empty in the .NET assembly runtime, DW.Print cannot
print to a physical printer. It works in the WPF runtime.

Table 4. WPF RichText DataWindow Issues

CR# Description

621618 Large files in a RichText DataWindow object degrade performance.

When you save or open a RichText DataWindow object using a file of
400KB or greater, performance is slow.

613487 RichText column text is truncated incorrectly at page breaks.

If a RichText column crosses two pages, the text is truncated incorrectly at
the page break.

Known Issues
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Known Issues for WPF Controls
Learn about known issues and apply workarounds for WPF controls in PowerBuilder .NET.

Table 5. WPF Control Issues

CR# Description

676279 Build error when adding inherited SVO into a CVO .NET assembly.

If you create a SVUO for CVUO .NET assembly, inherit the SVUO and add
it into a CVUO, there is an error: Partial declarations of
'assembly.svuo_cmb_b' have conflicting ac-
cessibility modifiers.

675923 Adding a CVUO to a CVUO triggers the Constructor event twice
in .NET Assembly targets at runtime.

In .NET Assembly targets, if you add a CVUO to another CVUO, the
Constructor event is triggered twice at runtime.

675759 Height and width of StaticText controls changes after migrating target.

When you migrate a StaticText control from PowerBuilder .NET 12.1 to
12.5, the height and width properties change.

663341 GAC interferes with adding CVUO to Visual Studio toolbox.

You can add the CVUO to the global assembly cache (GAC), but you cannot
then add it to the Visual Studio toolbox. If the CVUO is not in the GAC, you
can add it into the toolbox.

572458 Adding a tab page item causes design-time flickering.

When you select the Add Tab context menu item on a Tab control at design
time, you may see a slight flickering on the monitor.

572400 TabPage tabs can extend beyond a Tab control.

If you add several tab pages to a Tab control, PowerBuilder automatically
adds arrow buttons to allow users to click through all of the tabs, some of
which are hidden. However, in PowerBuilder .NET, the arrow buttons can
hide part of the text of a TabPage, giving it a cut-off appearance at design
time and runtime. At design time, the outline of a tab page may appear
outside the boundaries of the main Tab control.

Known Issues
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CR# Description

570542 TextCase property must be reset in some instances.

If you add mixed-case text to a SingleLineEdit control while the TextCase
property in the Properties view is set to Upper! or Lower!, the text does not
automatically use the case indicated by the property.

Workaround: You can change the case by selecting a different value for the
TextCase property, then reselecting the original value.

Known Issues for Third-Party and Custom Controls
Learn about known issues and apply workarounds for third-party and custom controls in
PowerBuilder.

Table 6. Third-Party Control Issues

CR# Description

673839 Updatable columns listbox malfunctions when the list of columns is
larger than what fits on one screen.

For example, open the Update Properties dialog for the listbox. In the
Updatable Columns listbox, select the ID column: this is now unselected
and the columns are selected. Scroll down and then back up: more items are
unselected.

640523 WPF Publish SmartClient application fails when third-party controls
are included.

If a WPF application includes third-party controls and the required refer-
ence assembly files are not in a build subfolder (..\bin\Debug or ..
\bin\Release), when you publish it as a SmartClient application, the
publish does not copy related files to the publish folder (..\bin\De-
bug\published or ..\bin\Release\published).

Workaround: Copy all required assembly files to the build subfolder (..
\bin\Debug or ..\bin\Release) according to the section
<ReferenceAssemblyFiles> of the publish.xml (also in the build
subfolder). The publish is then successful.

635007 XAML best practices for third-party controls.

Define the third-party namespaces in the XAML root element before add-
ing third-party controls. If you do not, an incorrect namespace is added
inline and causes XAML namespace errors.

Known Issues
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CR# Description

633431 Sometimes a new Toolbox tab that you added will disappear.

If you add a new tab to the Toolbox and then PowerBuilder .NET crashes,
the new tab is not saved.

626856 Using third-party controls that refer to different versions of WPFTool-
kit.dll causes build error.

The WPFToolkit.dll (version 3.5.40320.1), referenced by WPF
applications in PowerBuilder .NET, is added automatically. If you use other
third-party WPF controls that reference different versions of WPFTool-
kit.dll, you see the build error: The located assembly's
manifest definition does not match the as-
sembly reference.

621554 Double-clicking some third-party controls does not open the Script
view.

The Script view does not open automatically when you double-click some
third-party controls, such as RadCalendar, in a Layout view. This issue also
exists in Visual Studio.

Workaround: Open the Script view for the window or parent control and
select the third-party control from the top left drop-down list.

Known Issues for WPF Inheritance
Learn about known issues and apply workarounds for inheritance in PowerBuilder .NET.

Table 7. WPF Inheritance Issues

CR# Description

697229 You cannot switch to customized Constructor events in a CVUO's
descendant.

When you inherit from a custom nonvisual class in a referenced PB as-
sembly, the nonvisual class has several customized Constructor events. In
the descendants, you cannot select the Constructor from the event list and
then switch to the +Constructor(…) event. If you continue to inherit from
the descendant, the customized Constructor events are lost in the script
painter’s event list.

Known Issues
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624278 Deleting ancestor menu items can cause descendant menus to fail in-
tegrity check.

When you delete a menu item in an ancestor menu, the Object Integrity
Failure dialog box sometimes appears when you try to open the descendant
menu, and the descendant menu may be blank if you subsequently open it in
the Menu painter.

Workaround: Click OK in the Object Integrity Failure dialog box, then
select PowerScript Editor in the Open With dialog box. The editor high-
lights the deleted menu item in source code with a straight red underline. If
you comment out or delete all Type ... End Type and On ... End On clauses
containing the underlined menu item, you can open the descendant menu
again in the Menu painter.

Known Issues for .NET Language Enhancements
Learn about known issues and apply workarounds for the .NET language enhancements in
PowerBuilder.

Table 8. .NET Language Enhancement Issues

CR# Description

649531 You can connect a PowerBuilder event or function to a .NET event only
if it was defined outside of PowerBuilder.

.NET events are different from PB events: a .NET event is a delegate in-
stance, while a PB event is a method that can be used as a handler of a .NET
event. You can define a .NET event only outside of PowerBuilder. To learn
which .NET events are in a third-party control or regular .NET class, check
the metadata using .NET reflection tool or a related document.

620924 Deleting parameterized constructor does not remove inherited con-
structor in child object.

If you extend a parameterized constructor by adding code to it in a child
object, then delete the parameterized constructor in the parent object, the
child object source code still contains a hidden system-generated script that
calls the deleted parent constructor. This leads to a compile failure.

Known Issues
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Known Issues for the WPF Runtime
Learn about known issues and apply workarounds in PowerBuilder .NET WPF applications at
runtime.

Table 9. WPF Runtime Issues

CR# Description

655873 Embedded non-image file resources do not load.

You cannot use file-based system functions to embed non-image external
resources in PowerBuilder code for a WPF target.

For example, if you change the build action of a text file from normal
content to an embedded resource, the resource fails to load at runtime.

655701 External content resources for third-party controls do not load.

External content resources for third-party controls (for example, the Mi-
crosoft WPF Image control) fail to load at runtime. Only embedded re-
sources are loaded successfully at runtime.

618158 Dragging a toolbar does not trigger the ToolbarMoved event.

In PowerBuilder .NET, the ToolbarMoved event is triggered for an SDI
window only when you open the window.

590157 Culture settings issues in DatePicker and MonthCalendar controls.

The masks for enabling single-digit values for the hour in 12-hour or 24-
hour formats (h and H) do not work properly. In PowerBuilder .NET, they
work the same as the hh and HH masks, and always present hour values with
two digits.

585399 Application and assemblies cannot have identical names.

A runtime error occurs when you use the same name for an assembly and
the WPF application that references the assembly.

Workaround: In a WCF Client Proxy project, do not name the generated
assembly with the name of the WPF application that hosts the project.

582510 Multiple-item selection in a ListView control.

Multiple-item selection in a ListView control is enabled when the Exten-
dedSelection property is set to true. However, in WPF applications, users
cannot use the mouse to lasso the items they want to select.

Workaround: In WPF applications, users must hold down the Shift key to
select multiple items.

Known Issues
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Known Issues for the WPF Debugger
Learn about known issues and apply workarounds for the WPF Debugger.

Table 10. WPF Debugger Issues

CR# Description

676190 The debugger does not display value tips for shared variables.

For shared variables, expressions like this are evaluated:

PBGlobalDefinitions_pb12wpfdebug.GetIn-
stance().w_main_6__s_ulong_7
This is satisfactory for the watch window. But for tooltips, function calls are
not accepted. Change GetInstance to a GetProperty.

661095 Breakpoints not found in objects of same name in different targets

If there are two objects with the same name in different targets, and you
attempt to go to a breakpoint in one of the objects, the debugger cannot open
the correct source code and go to the correct breakpoint. This is a limitation
of editing source code at the level of routines instead of as files.

637697 Array expressions in PowerBuilder .NET Debugger Watch view

The PowerBuilder .NET Debugger Watch view cannot evaluate an expres-
sion that includes an array.

620549 Zero-based arrays not shown correctly in debugger.

The debugger incorrectly displays zero-based object arrays used by some
Web services.

620068 Go To Source Code works only for single target.

In some debugger windows, you can select a breakpoint and use the Go To
Source Code command to open the source code at that breakpoint. This
command works incorrectly for a breakpoint in a PowerBuilder .NET
workspace that has multiple PowerBuilder .NET targets.

616269 Incorrect CheckBox control properties in QuickWatch window.

The QuickWatch window displays some CheckBox control properties in-
correctly.

614864 Unwanted temporary variables in debugger output.

Temporary variables that do not exist in the application code (for example,
__PB_TEMP_DB__OutputVars0), may appear in some debugger
windows.

Workaround: You can safely ignore these temporary variables.

Known Issues

12 PowerBuilder



CR# Description

610237 Cursor stops twice for FOR...NEXT statements.

If you set a breakpoint immediately prior to a FOR...NEXT statement, then
issue successive Step Into commands, the WPF Debugger cursor stops
twice at the line with the FOR clause.

Known Issues for the WCF Client Proxy
Learn about known issues and apply workarounds for the WCF client proxy in
PowerBuilder .NET.

Table 11. WCF Client Proxy Issues

CR# Description

616323 WCF client does not work with IssuedToken client credential in FDCC
environment.

The IssuedToken client credential uses SHA1Managed cryptography,
which is not compliant with the Federal Information Processing Standard
(FIPS) for cryptographic modules. This causes the WCF client communi-
cation request to fail from computers using the Federal Desktop Core Con-
figuration (FDCC).

590729 Redeploying a project with the Window painter open.

If you keep a WPF window open while redeploying a WCF Client Proxy
project, a message on top of the Window painter prompts you to reload the
designer.

Known Issues for the WCF Services
Learn about known issues and apply workarounds for the WCF services in
PowerBuilder .NET.

Table 12. WCF Services Issues

CR# Description

697983 Remote deployment fails when the remote server is running Windows
7.

The error message reads: Could not find file "...
\pbxxxx.tmp.txt."

Known Issues
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CR# Description

672164 WCF service will not build if a parent NVO has non-public members.

If the function name is the same as the property name, there is an error
Csc: Error CS0103 n_parent (17,11): The name
'pbp_p_protected_get' does not exist in the
current context and the WCF service does not build.

667433 WCF service attribute settings lost after opening a Beta project.

If you open a WCF service project that was created in a Beta build of
PowerBuilder .NET, all attribute settings are lost. Reset the attributes.

663912 WCF service fails to invoke a specific function.

A WCF service with an enum causes the error Underlying con-
nection is closed.

Known Issues for the FlowDirection Property
Learn about known issues and apply workarounds for the FlowDirection property in
PowerBuilder .NET.

Table 13. FlowDirection Property Issues

CR# Description

590684 Preview view does not display flow direction set in application.

When you preview a window in an application that has a right-to-left flow
direction set on the Application object, but not on the window being pre-
viewed, the preview does not show the window with the right-to-left flow
direction. For the preview to work correctly, you must also set the flow
direction on the window you want to preview.

Known Issues
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Known Issues for Migration
Learn about known issues and apply workarounds for the migration to PowerBuilder .NET.

Table 14. Migration Issues

CR# Description

634087 OLE controls can be migrated but not added or edited.

You can migrate a PowerBuilder Classic application with OLE controls to a
WPF application in PowerBuilder .NET. You cannot add or edit OLE con-
trols in the migrated application. Editing controls in the XAML view may
cause a full build error (for example, copying and pasting OLE controls in
the XAML view).

621806 Blank area appears in MDI windows after migration.

In PowerBuilder Classic, the toolbar for an MDI or MDIHelp window
occupies an otherwise empty space in the client area of the window. In
PowerBuilder .NET, the space occupied by the toolbar is not part of the
client area, so when you migrate MDI windows, the space previously oc-
cupied by the toolbar appears blank.

Workaround: After migration, move the controls in MDI windows to
cover the client area previously occupied by the toolbar.

Known Issues
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Known Issues for Installation
Learn about known issues and apply workarounds for the PowerBuilder setup program.

Table 15. Installation Issues

CR# Description

672300, 674208 PowerBuilder 12.5 installation affects PowerBuilder 12.1 installation.

After a PowerBuilder 12.5 installation, you cannot expand these Power-
Builder 12.1 system assemblies in 12.1 target references:

Sybase.PowerBuilder.WCF.dll
Sybase.PowerBuilder.WPF.dll
Sybase.PowerBuilder.WPF.Skins.dll

This issue prevents windows and visual user objects from opening in ex-
isting WPF targets. It does not cause build and runtime problems.

Workaround: Manually restore the assemblies:

1. Open a .NET target.
2. If you cannot expand any of the PowerBuilder 12.1 system assemblies

in the reference list:
a. Remove the item from the list.
b. Add the the corresponding assembly to the list from the Power-

Builder 12.1 installation (for example, C:\Program Files
\Sybase\PowerBuilder 12.0\DotNET\bin).

3. Save the target.

623693 Local SySAM license may cause failure when server license is installed.

If you install PowerBuilder using a local license on a SySAM license server,
the setup program may fail.

Workaround: Install PowerBuilder on the license server with an evalua-
tion license, then update the license from the Tools menu of a PowerBuilder
IDE.

607351 Error message appears during SQL Anywhere® installation.

On the last step of the SQL Anywhere installer in the PowerBuilder setup
program, you may see: Invalid license data. Reinstall
is required.
Workaround: Click OK to dismiss the dialog box. The SQL Anywhere
installation completes normally.

Known Issues
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Known Issues for Split Assemblies
Learn about known issues and apply workarounds for split assemblies in PowerBuilder .NET.

Table 16. Split Assembly Issues

CR# Description

657114 Running the full build process after making changes in the scripts does
not automatically trigger the dependency check.

There may be build errors if there are potential dependency errors.

Workaround: Run a manual dependency check if the changes might affect
the dependency result.

647772 Split assembly dependency check error for global external functions.

When you run a dependency check on a project with split assemblies, there
is a dependency error on the lines calling global external functions. To avoid
this, refactor by replacing the global external functions with local external
functions.

644570 The executable is not created if a PBL contains an application object
going into a split assembly.

The output assembly has a red border and tooltip indication if there is a
duplicated name (assembly and executable). Also, the name is ignored
when it is saved.

If the PBL has the same name as the executable file, then by default the DLL
is filtered out of the Output Assembly list.

Known Issues for Miscellaneous Items
Learn about known issues and apply workarounds for miscellaneous items in PowerBuilder.

Table 17. Miscellaneous Issues in PowerBuilder

CR# Description

676276 Changing screen resolution affects appearance at runtime.

If you change the screen resolution, there are differences between the ap-
pearance at design time and runtime.

675440 Pressing Shift + F1 in Script painter does not open content directly.

Sybase cannot replicate the behavior of Windows Help using HTML Help.
Windows Help has been deprecated by Microsoft.

Known Issues
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CR# Description

674639 Shortcut key for Assembly Dependencies window changed.

In PB12.1 .NET IDE, the keyboard shortcut to open the Assembly De-
pendencies window (Ctrl+Alt+A in the earlier version) has been changed
to Ctrl+Alt+D.

674143 3-D property does not affect Checkbox control in Windows XP.

In the Windows XP theme, the 3-D property does not affect the appearance
of the Checkbox control. It always appears as 3-D.

673442 Uninstalling .NET assembly case shows non-English interface.

If you uninstall a .NET assembly case, you see a non-English interface
(such as the German language).

672005 Inherited public .NET properties are not exposed to a .NET assembly.

The public properties of an NVO inherited from a .NET class are not ex-
posed in a .NET assembly.

670814 .NET assembly's Array property has issues in the deployed DLL.

The Array property is not exposed in a deployed DLL, nor is an array's
instance variable that is named "names." Other instance variables are ex-
posed.

654850 Temporary class members appear in .NET Assembly target project's
Object tab.

If you create a class member but do not save it, then open the project, that
new class member is listed in the Object tab.

634891 You cannot toggle InputFieldNamesVisible after using PasteRTF.

626344 Inconsistent save behavior.

In Windows 7, PowerBuilder .NET behavior is inconsistent when saving
objects, depending on the type of object and the type of Windows user. For
example, PowerBuilder might clear the layout view after an administrator
saves a window painter, but not if a regular user launches the IDE using Run
As Administrator.

623684 Error creating project with standard user login.

If the current user does not have write permission for the directory assigned
to the TMP environment variable, an error message appears in the Output
window after the user attemps to create a project with a target or project
wizard.

Workaround: Set the TMP variable to a directory for which the current
user has write permission.

Known Issues
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CR# Description

617268 GetLatestVersion does not get all files added to Perforce by another
user.

If two users add the same solution from a Perforce 2008 depot, then the first
user checks in a new object for the solution, the second user can select Get
Latest User (Recursive) to add the new object. However, although the new
object is visible in the Solution Explorer of the second user, it is not added to
that user's PBL directory.

Workaround: The second user must close and reopen the solution to
complete the GetLatestUser action and get all the updates.

616577 Double-clicking resource items on FDCC-certified XP computers.

Although double-clicking a resource item in the Solution Explorer should
open the editor associated with the item's file type, on FDCC-configured
Windows XP computers, the Move dialog box opens instead. This does not
occur on non-FDCC computers or on FDCC-configured computers using
the Windows Vista operating system.

Workaround: To enable the correct editor to open:

1. In the Solution Explorer, right-click the resource item.
2. Select Add to open the Add Program dialog box.
3. Browse to the program you want to use to open files of the type you

right-clicked in step 1.
4. If necessary, change the Friendly Name of the program you selected in

step 3 and click OK.
5. In the Open With dialog box, select the friendly name from step 4, click

Set as Default, then click OK.
6. Repeat this process for all other types of resource items you want to

open from the Solution Explorer.

572522 Problem Starting SySAM License Server

If your Windows license server host has IPv6 enabled, the served license
does not perform correctly. See PowerBuilder Installation Guide > Plan-
ning Your Installation > Obtaining a License > SySAM Troubleshooting >
Problem Starting SySAM License Server.

569483 New targets in root path of the c: drive are not visible.

In PowerBuilder .NET, if you create a workspace in the root path of the c:
drive, then create a target in the root path, the target does not appear in the
Solution Explorer.

Known Issues
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Product Compatibilities

PowerBuilder has been tested for compatibility with a number of software products.

Table 18. Software Products Tested with PowerBuilder

Software Type or
Product

Compatibility Description

Application servers PowerBuilder Classic has been tested with EAServer 6.3.1.

SQL Anywhere PowerBuilder 12.5.1 has been tested with SQL Anywhere 12.0.1.

PowerDesigner PowerBuilder 12.5.1 has been tested with PowerDesigner® 15.3 ESD
#9.

Microsoft .NET Frame-
work

PowerBuilder .NET and PowerBuilder Classic are compatible with Mi-
crosoft .NET Framework 4.0 and later.

Java PowerBuilder Classic is compatible with JDK 1.5 and 1.6.

Ghostscript The DataWindow Save As PDF feature has been tested with AFPL
Ghostscript version 8.60.

Product Compatibilities
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Third-Party Components and Deployment

PowerBuilder applications have some dependencies on third-party components that are
installed with PowerBuilder.

Most of these components are not installed with the PowerBuilder Runtime Packager. You
may redistribute some of these components with your application, but others must be obtained
from the vendor.

For information about components that you can download freely, see the free download terms
document, available from the Support directory on the DVD and on the Sybase Web site at
http://www.sybase.com/softwarelicenses/third_party_legal.

Apache Files
You may redistribute the Apache files that are included with PowerBuilder to your users.

Any use or distribution of the Apache code included with PowerBuilder 12.5 must comply
with the terms of the Apache License, which is located in the free download terms document
for PowerBuilder.

Version 0.20.5 of the Apache Formatting Objects Processor (FOP) is required if your
application uses XSL-FO to save files as PDF. See the Apache FOP Web site at http://
xmlgraphics.apache.org/fop/.

The Apache Xerces files xerces-c_2_6.dll and xerces-depdom_2_6.dll are
required for XML Web DataWindow support, XML support for DataWindows and
DataStores, PBDOM, and SOAP clients for Web services. See the Xerces C++ Parser Web site
at http://xml.apache.org/xerces-c/.

Microsoft Files
Special Microsoft files are required on runtime computers for various PowerBuilder features.

Visual C++ Runtime and the Active Template Library
When you deploy the core PowerBuilder runtime files, make sure the msvcr71.dll and
msvcp71.dll Microsoft Visual C++ runtime libraries and the Microsoft .NET Active
Template Library (ATL) module, atl71.dll, are present on the user’s computer or server.

The PowerBuilder runtime files have a runtime dependency on these files and they are
required for all applications and components that require the PowerBuilder runtime. You can
obtain these files from DLL archive Web sites at http://dlldump.com or http://
driverskit.com/.
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Note: Some files that are installed by the MSI file generated by the PowerBuilder Runtime
Packager have dependencies on these files. For example, atl71.dll must be installed on
the user’s computer before the pbjvmversion.dll file can be registered. Make sure these
files are on the target computer before you run the MSI file generated by the Runtime
Packager.

Ink Picture Libraries
Microsoft.Ink, Microsoft.Ink.dll, and Microsoft.Resources.dll are
required if your application uses InkEdit and InkPicture controls. These files are part of the
Microsoft Windows XP Tablet PC Edition Software Development Kit 1.7 that is available on
the Microsoft Web site at http://www.microsoft.com/downloads/details.aspx?
FamilyId=B46D4B83-A821-40BC-AA85-C9EE3D6E9699&displaylang=en.

Microsoft has discovered some compatibility issues between these DLLs and the .NET
Framework 2.0. You can obtain an update that addresses these issues from the Microsoft Web
site at http://www.microsoft.com/downloads/details.aspx?familyid=
84BBEFA4-7047-41DF-8583-E3BDBF9D805F&displaylang=en.

DirectX 9.0c Runtime
PowerBuilder applications can use DirectX 3D rendering to display 3D graphs (Pie3D,
Bar3D, Column3D, Line3D, and Area3D) with a more sophisticated look. You can use data
item or series transparency with the DirectX graph styles to improve the presentation of data.

The DirectX 3D rendering depends on the DirectX 9.0c runtime. The first time you select the
Render3D check box on the General tab of the Properties view for a 3D graph, PowerBuilder
launches the DirectX installer. If you opt out of the installation, the Render3D property is
ignored. End users of PowerBuilder applications must also have the DirectX 9.0c runtime
installed on their computers to view the DirectX graph styles. You can download the DirectX
9.0c runtime from the Microsoft Web site at http://www.microsoft.com/downloads/
details.aspx?FamilyID=2da43d38-db71-4c1b-bc6a-9b6652cd92a3&DisplayLang=en.

For computers with older graphics drivers, you can check whether DirectX is supported by
running dxdiag.exe. This file is typically installed in the Windows\System32
directory. The Display tab of the DirectX Diagnostic Tool that opens when you run
dxdiag.exe indicates whether Direct3D is enabled.

Oracle (Sun Microsystems) Files
The Java Runtime Environment (JRE) is required for EJB clients, JDBC connections, and
saving objects and documents to PDF files using XSL-FO.

For a copy of third-party terms and conditions for the JRE, see the free download terms
document. You can download the JRE from the Sun Developer Network at http://
java.sun.com/javase/downloads/index.jsp.
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Software Used for SOAP Clients for Web Services
PowerBuilder Classic applications can use EasySoap to connect to Web services. The
EasySoap++ library in executable form (EasySoap125.dll), which is dynamically linked
to PBSoapClient125.pbx, is distributed with PowerBuilder.

The EasySoap++ library and its use are covered by the GNU Lesser General Public License
(LGPL). For a copy of this license, see the free download terms document.

You may distribute the EasySoap++ library to third parties, subject to the terms and conditions
of the LGPL.

The complete machine-readable source code for the EasySoap++ library is in the
EasySoap.zip file in the Support\WSExtn folder on the DVD. In addition, the object
code and Microsoft Visual C++ project file for the PBSoapClient125.pbx are in the
soapclient.zip file in the same directory.

These files are provided under the terms of the LGPL so you can modify the EasySoap++
library and then relink to produce a modified EasySoap125.dll. You can also relink
PBSoapClient125.pbx with the modified EasySoap++ import library. According to the
terms of the LPGL, you may not be able to recompile PBSoapClient125.pbx to use the
definitions you have modified in the EasySoap++ library.

Follow the instructions in the Readme.txt file in the soapclient.zip file to build
PBSoapClient125.pbx.
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Documentation Updates and Clarifications

Read about corrections and clarifications to released documentation for PowerBuilder 12.5.2.

Table 19. PowerBuilder Documentation Issues

CR# Description

745295 SaveAsType XLSX! and XLSB! requires .NET Framework 4.0

To save as a Microsoft Excel 2007 format for XML or binary data, you must
have .NET Framework 4.0 or later installed.

Applies to DataWindow Reference > DataWindow Constants > SaveAsT-
ype.

741783 Use Selected.Mouse object property in conjunction with Protect object
property

This note should be added to the Usage section of the DataWindow object
property topic Selected.Mouse in the DataWindow Reference:

Note: If a column is protected and dw_control.Object.Selected.Mouse =
"No", than you cannot select a column. You can still select the column
header, however, which will highlight the entire column. You should set
Selected.Mouse to "No", Protect to 1, and Grid.ColumnMove to "No".

Users should also refer to the Protect and Grid.ColumnMove object prop-
erty topics in the DataWindow Reference.

736338 Update to ORCA appendix in Users Guide

On the first page of Appendix B: The OrcaScript Language in the Power-
Builder Users Guide, it states that the full ORCA tool kit is available to
Sybase partners only, but this is not the case. The files ship with the product:

• The Orca header file, lib file, and documentation (orca125.pdf)
are in ..\Sybase\PowerBuilder 12.5\SDK\ORCA di-
rectory.

• PBORC125.dll is in the ..\Shared\PowerBuilder di-
rectory.

731412 Support for 32-bit Outlook and simple MAPI only

At this time only 32-bit Outlook is supported, and the simple messaging
application program interface (MAPI). PowerBuilder does not support 64-
bit Outlook.
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CR# Description

730975 Outdated information about help files on Vista

Disregard the section in the InfoMaker Users Guide > InfoMaker Envi-
ronment > Working with InfoMaker > Windows help files on Vista. Pow-
erBuilder and InfoMaker no longer ship with WinHelp.

728727 Selecting Windows Classic Style removes the manifest file

Corrected Text: When you select the Windows Classic Style check box in
the application project, the application appears with the standard controls.

This correction applies to PowerBuilder Users Guide > Running Your
Application > Creating Executables and Components > Defining an exe-
cutable application project.

727830 Overflow of real, double, and decimal values does not cause runtime
errors

In the PowerScript Reference topic Arithmetic operators in PowerBuilder,
the Errors and overflows section states that "Overflow of real, double, and
decimal values causes errors at runtime" but they do not. You can overflow
real, double, and decimal values.

720479 Corrections to database drivers and supporting files for SQL Any-
where

There are some corrections to the file names for SQL Anywhere in the
Application Techniques topic ODBC Database Drivers and Supporting
Files.

• Remove rteng11.exe and rteng11.lic from Table 36-9:
SQL Anywhere Files.

• Change “...the SQL Anywhere restricted runtime engine
(rteng11.exe) and other SQL Anywhere executables require
elevated privileges” to “...the SQL Anywhere executables require ele-
vated privileges.”

• Update "Start"="c:\program files\sybase\SQL
Anywhere 12\bin32\rteng11.exe -c9m" to
"Start"="c:\program files\sybase\SQL Any-
where 12\bin32\dbeng12.exe -c9m" in the code ex-
ample for configuring ODBC data sources and drivers.

720138, 621820 New SoapConnection functions

There are two new functions in the SoapConnection class. See Enable-
PreAuthentication on page 31 and SetKeepAlive on page 32. This
affects the Extension Reference.
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CR# Description

None SoapConnection methods

Corrected Text: In the Extension Reference, these methods are for .NET
Web services engines only: AddToBypassList, DynamicCast, RemoveBy-
passList, SetBypassProxyOnLocal, SetClientCertificateFile, SetUseDe-
faultProxySetting, and UseIntegratedWindowsAuthentication. These
methods are for EasySoap Web services engines only: SetSoapLogFile and
UseConnectionCache.

718173 Correction to syntax for Transparency (DataWindow objects)

This applies to the DataWindow Reference and the InfoMaker Users
Guide.

Corrected Text:

PowerBuilder dot notation: dw_control.Object.DataWind-
ow.transparency
Describe and Modify argument: "DataWindow.transparency
{ = integer }"

715058 GetFileOpenName function behavior differences between operating
systems

The initdir parameter in GetFileOpenName function uses some different
algorithms in Windows 2000/XP/Vista from Windows 7, which are de-
scribed in detail in Initdir Parameter Behavior in GetFileOpenName Func-
tion on page 33.

712849 Find Function Enhancement

The Find function now has a buffer argument. You can use the new buffer
argument to find data in the Delete! or Filter! buffers. The default value is
Primary! The argument is optional.

long dwcontrol.Find (string expression, long 
start, long end{, DWbuffer buffer})
This was documented in the 12.1 Release Bulletin, but not added to the core
documentation. It should be included in 12.5 and later.

705028 Providing support for NULL values in EAServer Components

Corrected text: Proxy objects do not include the suffix "_N" in the func-
tion name. In Application Techniques, Defining the component interface,
the paragraph that begins "If you allow null values in the prototype for a
component method, PowerBuilder appends a “_N” suffix to the method
name" should be removed entirely.
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CR# Description

701504 Create white list of Web sites for Web Forms applications

You can set PBAllowDownloadUrls in the Project Painter. It is a white list
of Web sites, separated by semicolons. By setting this list, PowerBuilder
accepts only the URLs of the sites in this list, which allows you to provide
added security to your application. The list is not case sensitive. Include
"http:\\" or "https:\\" in the URLs.

699475 In Connecting to Your Database > Chapter 9: Using Microsoft SQL Server
> SQL Server 2008 features > Support for new datatypes in SQL Server
2008, the first sentence of the Precisions Settings paragraph should read:
"PowerBuilder includes a column labeled "Dec" in the Columns view of the
Database painter..."

692447 Incorrect datatype mappings for PowerBuilder .NET

Corrected text: PowerBuilder Date and Time variables need to be con-
verted to DateTime when calling a C# assembly. You can call PowerBuilder
assemblies with the Date and Time variables and perform the conversion
within the assemblies. See PowerBuilder .NET Datatype Mapping on page
33.

677259 Windows Forms and Web Forms require two DLLs, in addition to DLLs
currently listed: msvcr100.dll and msvcp100.dll. The docu-
mentation was updated in the PowerBuilder .NET Features Guide and
Deploying Applications to .NET; however, it has not been updated in Ap-
plication Techniques.

In Application Techniques, everywhere that msvcr71.dll and
msvcp71.dll are listed, add msvcr100.dll and
msvcp100.dll to the required DLLs.

668659 Debugger Changes

New text: Only a debug version can be debugged; the release version
cannot be debugged. If a debug version does not exist, the debugger fails.
This is not related to the build type set in the Project painter.

639448 Unsupported Properties, Events, and Functions

New text: You cannot use the Border property for custom controls. If
multiple objects are selected including the custom control, you can set the
Border property for the objects that do support the Border property. The
setting is ignored for the objects that do not support that property.

638096 Oracle8i native interface is not available in PB 11.5 and later

Corrected text: Table 1-4 in Checklist for deployment in Deploying Ap-
plications and Components to .NET includes pbo84125.dll but support for
the Oracle8i native interface has been discontinued as of PowerBuilder
11.5. The pbo84125.dll should be removed from the table.
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635140 Unsupported Properties, Events, and Functions

Updated text: In PowerBuilder 12.1, the DisplayOnly property for Rich-
TextEdit is supported.

624234 Application Server Plug-in

Corrected text: Application Techniques and the Users Guide include in-
formation about the Application Server plug-in, but support for this plug-in
has been discontinued as of PowerBuilder 12.0.

624126 ToolbarAlignment window property

New text: The  Features Guide does not list Floating! as an unsupported
enumerated value for the ToolbarAlignment property. In migrated appli-
cations that retain this value, toolbars align at the top of a window.

605201 Behavior Changes for DataWindow Objects

New text: PrintPage behavior: In PowerBuilder Classic, when the return
code is set to 1, the page is not printed. In PowerBuilder .NET, when the
return code is set to 1, the page prints.

EnablePreAuthentication
Call this function to pre-authenticate the request. This function applies only to webservices
that use basic authentication mechanism. This method is available for .NET Web services
engine only.

Syntax
conn.EnablePreAuthentication()

Argument Description

conn The name of the SoapConnection object that es-
tablishes the connection.

Returns
Long. Valid values are 0 for success and 50 for failure.

Usage
For basic authentication, a request is made to the XML Web service method without initially
attempting to authenticate the user.

• If the XML Web service allows anonymous access, then the XML Web service method
executes.

• If anonymous access is disallowed, a 401 HTTP return code is sent to the client.
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In response, the proxy class returns the authentication credentials to the Web server. If the
client is authenticated and subsequently authorized to access the XML Web service, the XML
Web service method is executed; otherwise the client is denied access.

To summarize, any call to a Web service's method generates at least one 401 error for basic
authentication. This behavior does not work with some older versions of the Apache HTTP
server, however, and sends a 500 response if a client does not include credentials on the very
first request to the server. This behavior violates the guidance from RFCs 2616 and 2617,
which suggests that a server should respond with a 401 to a request that has no Authorization
header.

To call Web Services located in older Apache servers, or to decrease the roundtrips to the
server which you have trusted in advance, call the EnablePreAuthentication function of
SoapConnection before you create the proxy object. When calling this function, the WWW-
authenticate header is sent with the first request for basic authentication.

SetKeepAlive
Indicates whether to make a persistent connection to the Internet resource. This method is
available for .NET Web services engine only.

Syntax
conn.SetKeepAlive (boolean value)

Argument Description

conn The name of the SoapConnection object that es-
tablishes the connection.

value A boolean value that, when true, indicates that the
request to the Internet resource contains a Con-
nection HTTP header with the value Keep-
alive. The default is true.

Results
Long. Valid values are 0 for success and 50 for failure.

Usage
Use SetKeepAlive(true) to send a Connection HTTP header with the value Keep-
Alive, which indicates a preference for persistent connections. When calling
SetKeepAlive(true), the application makes persistent connections to the servers that
support them.

When using HTTP/1.1, Keep-Alive is on by default. SetKeepAlive(false) may
send a Connection: Close header to the server.
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If you get the error message "The underlying connection was closed: A connection that was
expected to be kept alive was closed by the server" when you call the Web service, you can
attempt to call SetKeepAlive(false) before you create the proxy object.

Initdir Parameter Behavior in GetFileOpenName Function
The initdir parameter in GetFileOpenName function uses some different algorithms in
Windows 2000/XP/Vista from Windows 7.

Windows 2000/Windows XP/Windows Vista:

1. If filename contains a path, that path is the initial directory.
2. Otherwise, initdir specifies the initial directory.
3. If the application has used an Open or Save As dialog box in the past, the path most recently

used is selected as the initial directory. However, if an application is not run for a long time,
its saved path is discarded.

4. If initdir is NULL and the current directory contains any files of the specified filter types,
the initial directory is the current directory.

5. Otherwise, the initial directory is the personal files directory of the current user.
6. If no other conditions are met, the initial directory is the Desktop folder.

Windows 7:

1. If initdir has the same value that was selected in the first instance of the application's Open
or Save As dialog box, then it uses the path the user selected most recently as the initial
directory.

2. If filename contains a path, that path is the initial directory.
3. If initdir is not NULL, it specifies the initial directory.
4. If initdir is NULL and the current directory contains any files of the specified filter types,

the initial directory is the current directory.
5. Otherwise, the initial directory is the personal files directory of the current user.
6. If no other conditions are met, the initial directory is the Desktop folder.

PowerBuilder .NET Datatype Mapping
The PowerBuilder to .NET compiler converts PowerBuilder datatypes to .NET datatypes.

PowerBuilder C#

boolean bool

boolean[] bool[]

blob byte[]
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PowerBuilder C#

blob[] byte[][]

byte byte

byte[] byte[]

int short

int[] short[]

uint ushort

uint[] ushort[]

long int

long[] int[]

ulong uint

ulong[] uint[]

longlong long

longlong[] long[]

decimal decimal

decimal[] decimal[]

real float

real[] float[]

double double

double[] double[]

string string

string[] string[]

User-defined structure class 1

User-defined structure[] class [] 1

User-defined NVO object class

User-defined NVO object[] class [] 1

1 Data container class
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PowerBuilder C#

enumerated enum

enumerated[] enum[]

Time Not supported 2

Time[] Not supported 2

Date Not supported 2

Date[] Not supported 2

Datetime DateTime

Datetime[] DateTime[]

any Not supported

Multidimension array Not supported

PB system structure Not supported

PB system object type Not supported

PB system nvo type Not supported

User-defined non-NVO object Not supported

ResultSet and its descendants Not supported

Returning any Array type

Dot Net serializable type (with Serializable or
DataContract attributes)

Dot.Net serializable type

Dot Net primitive type Dot Net primitive type

2 PowerBuilder Date and Time variables need to be converted to DateTime when calling a C#
assembly. You can call PowerBuilder assemblies with the Date and Time variables and
perform the conversion within the assemblies.
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Migration Information

You can migrate a PowerBuilder application from any version of PowerBuilder directly to
PowerBuilder Classic. You cannot migrate applications from PowerBuilder .NET to
PowerBuilder Classic, or from PowerBuilder Classic to older versions of PowerBuilder.

Migrate older applications to PowerBuilder Classic before you port them to
PowerBuilder .NET.

Migration to PowerBuilder .NET
The WPF Window Application wizard in PowerBuilder .NET provides an option for
converting a standard PowerBuilder Classic client/server or a Windows Forms target to a WPF
Window Application target. The .NET Assembly wizard in PowerBuilder .NET provides an
option to convert a PowerBuilder Classic .NET Assembly target.

After you select these conversion options and click Finish, the wizards automatically migrate
the PowerBuilder Classic targets you select. However, you may still need to manually refactor
some applications after you convert them.

This table lists some of the features that require special attention after you migrate
applications from PowerBuilder Classic. Topic references in the table are to the
PowerBuilder .NET Features Guide.

Feature Effect of Migration

Accelerator characters Ampersand (&) changed to underscore (_). See
Accelerator Characters in Control Labels.

Conditionalized (preprocessor) code blocks Invalid code blocks for PowerBuilder .NET are
maintained, but ignored. See Conditional Com-
pilation in PowerBuilder .NET Targets.

Control handles Controls nested in windows do not have their own
handles. See Modified and Unsupported Features
in PowerBuilder .NET .

Dashes in identifiers Dashes are replaced with a string you can select in
the target wizard. See Coding Restrictions.

Event sequence May require manual refactoring. See Modified
and Unsupported Features in PowerBuild-
er .NET .

GroupBox controls Controls that are inside a GroupBox belong to the
GroupBox, not to the container of the GroupBox.
See Semantic Differences.
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Feature Effect of Migration

Large application migration May cause OutOfMemory error. Turn on 3G
switch to avoid this error. See Memory Tuning for
Large Applications.

Menu and toolbar styles Maintained from PowerBuilder Classic. If you
migrate PowerBuilder applications earlier than
11.0, menus and toolbars use traditional styles.
See Selecting a Toolbar Style and Menu Styles in
PowerBuilder .NET.

Non-TrueType fonts Visible at design time, but replaced at runtime.
See Modified and Unsupported Features in Pow-
erBuilder .NET .

Pipeline and Query objects Imported, but ignored at runtime. See Modified
and Unsupported Features in PowerBuild-
er .NET .

Resource files Resource directories that you select in the wizard
are copied relative to the new target path, based on
the relative path to the original target. See Adding
Resources to a Target and Project Painter User
Interface.

Skins Default skins are attributed to migrated applica-
tions. See Skin Selection for Applications and
Controls,

The WPF application includes migration options for applications with dashes in identifiers
and with right-to-left formatting. If you click Finish before making a migration option
selection, the wizard migrates the application using default settings for these options.

Migration to PowerBuilder Classic
You can migrate applications from any earlier version of PowerBuilder to PowerBuilder
Classic 12.5.

Before you migrate, back up your files and use the Migration Assistant to identify obsolete
code. The applications you build using the current version of PowerBuilder must be deployed
with the PowerBuilder runtime DLLs from the current version.

Note: The "Migrating PowerBuilder Applications" technical document on the Sybase Web
site at http://www.sybase.com/detail?id=1032777 includes information on changes to
PowerBuilder since version 6.5 that might affect the conversion of applications to a more
recent PowerBuilder version.
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Migrating .NET Targets from Earlier Versions of PowerBuilder
When you migrate .NET Web Service components, you might need to remove or install
supporting files on development and deployment computers.

If you deployed .NET projects from earlier versions of PowerBuilder, verify or complete these
steps before redeploying the migrated .NET projects:

• For .NET Windows Forms projects, select Full for the project rebuild type before you
redeploy your applications from PowerBuilder Classic for the first time.

• For .NET Web Service targets, clear ASP.NET temporary files for the application or
component on development computers and production servers.
The temporary files are located in the C:\WINDOWS\Microsoft.NET\Framework
\version\Temporary ASP.NET Files\projectName  directory, where
version is typically v2.0.50727, and projectName is the project’s Web application name or
its Web service virtual directory name.

• For all .NET targets, uninstall earlier versions of PowerBuilder runtime files (system
assemblies and win32 DLLs) on all deployment computers or servers, then install the
runtime files for the current version of PowerBuilder using the Runtime Packager or
another tool, as described in the “Checklist for deployment” section of the Deploying
Applications and Components to .NET book.

• To migrate a PowerBuilder 12.0 or 12.1 solution, open its .PBWX file using the File menu.
If you double-click or drag and drop the file into PowerBuilder .NET 12.5, the Visual
Studio Conversion wizard opens, inappropriately. You can use the double-click and drag-
and-drop methods to open PowerBuilder 12.5 solutions.

Note: You can convert .NET Windows Forms targets to WPF targets in PowerBuilder .NET.
Sybase suggests that you migrate older .NET Windows Forms targets to PowerBuilder Classic
before you convert them to WPF targets.

You cannot directly convert .NET Assembly targets in PowerBuilder Classic to .NET
Assembly targets in PowerBuilder .NET.

Migrating EAServer Targets
Migrating EAServer targets from earlier versions of PowerBuilder to PowerBuilder Classic
may require some additional considerations. PowerBuilder .NET does not support EAServer
targets.

Migrating Components to EAServer 6.0.1 or Later
Intercomponent calls from a PowerBuilder component running in EAServer 6.0.1 require
proxies for all called components. In earlier versions of EAServer, a PowerBuilder component
can sometimes call another PowerBuilder component running in the same server without the
use of a proxy, because the PowerBuilder VM dynamically creates a proxy for the component
using method names that match the names of the component's methods.
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In EAServer 6.0.1 and later, PowerBuilder components are wrapped as EJBs, providing an
extra layer of security and preventing the PowerBuilder VM from dynamically generating a
proxy with names that match the component's method names. Therefore, you must create a
proxy object for all components you invoke with intercomponent calls. Without a proxy
object, the TransactionServer object cannot obtain the correct method names of the
component you are calling.

Accessing EAServer Components from .NET Targets
PowerBuilder installs the EAServer DLLs, com.sybase.iiop.net.dll and
com.sybase.ejb.net.dll, in the Global Assembly Cache (GAC) on the development
computer, and requires these DLLs on runtime computers for applications that access
EAServer components from .NET targets. You can use the Runtime Packager to place these
DLLs in the GAC on deployment computers.

Note: The DLLs intalled by the PowerBuilder setup program have been tested, and are
compatible with EAServer 6.3.1. However, if you use an EAServer version other than 6.3.1,
Sybase recommends that you copy the DLLs from the EAServer/Lib directory to the GAC
of all computers where you deploy your applications. If you then run or re-run the Runtime
Packager, you must also recopy these DLLs to the GAC, because the Runtime Packager
overwrites them.

Creating an EJB Client Proxy for an EAServer 6.x Component
Building EJB client applications for EJBs running in EAServer 6.x requires additional steps
when you create the EJB client proxy.

1. Copy the packagename directory from the %DJC_HOME%\deploy\ejbjars\
directory on the server to the client computer, where packagename is the package that
contains the EJB you want to use.

2. In the Select EJB Component dialog box that you open from the EJB Client Proxy project
painter, add this directory to the class path.

3. Generate the proxy.

Creating a Client Application for an EAServer 6.x EJB Component
Building EJB client applications for EJBs running in EAServer 6.x requires additional steps
when you create the client.

1. Copy the eas-server-15.jar file (or eas-server-16.jar if you are using JDK
1.6.x) from the %DJC_HOME%\lib directory to the client computer and include its full
path in the client’s CLASSPATH.

2. Copy the stub files from %DJC_HOME%\genfiles\java\classes\ directory to
the client computer and include this path in the client’s CLASSPATH.

3. Copy the packagename directory from the %DJC_HOME%\deploy\ejbjars\
directory on the server to the client computer, where packagename is the package that
contains the EJB you want to use, and include this path in the client’s CLASSPATH.
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If you copied these files and directories to a directory on the client called EAServer6,
and you want to use an EJB in a package named datamapping, the client CLASSPATH
setting might look like this:

Classpath=D:\EAServer6\lib\eas-server-15.jar;D:
\EAServer6\genfiles\java\classes;D:\EAServer6\deploy\ejbjars
\datamapping

System Types as Variable Names in Proxies
In PowerBuilder versions 10.5 and later, you cannot use system types as variable names in
Web service proxies.

If a PowerBuilder system type is used as a variable name, the Web Service Proxy wizard
renames the variable by applying the prefix ws_. If you are migrating Web service
applications from PowerBuilder 10.2 or earlier, and regenerating the Web service proxies in
PowerBuilder 10.5 or later, you may need to modify your code to reflect the change in variable
names.

PowerBuilder system types include not only the objects and controls listed on the System tab
page in the PowerBuilder Browser, but also the enumerated types listed on the Enumerated
page in the Browser, such as band, button, encoding, location, and weekday. For example, if
you build a Web service from a PowerBuilder custom class user object, and one of its functions
has a string argument named location, in the proxy generated for that Web service, the
argument is changed to ws_location.

OLE DB Performance with Microsoft SQL Server
In PowerBuilder 10.5.2 and later, when you use the OLE DB database interface with a
Microsoft SQL Server database and retrieve data into a DataWindow, or use an embedded
SQL cursor in a SELECT statement, server-side cursors help to support multiple command
execution.

If this has a negative impact on performance, try increasing the size of the Block database
parameter to 500 or more, or adding the following line to the [Microsoft SQL Server] section
in the PBODB initialization file to turn off server-side cursors:

     ServerCursor = 'NO'

Change in Behavior of OpenTab
A change was made in PowerBuilder 10.2.1 Build 9716, PowerBuilder 10.5.1 Build 6505, and
PowerBuilder 11.0 Build 5021, to correct an anomalous behavior when the SelectedTab
property was applied at runtime to a tab for which the Visible property was set to false.

As a result of this change, there is a change in the behavior of the OpenTab and
OpenTabWithParm functions. In earlier versions, calling the OpenTab or OpenTabWithParm
function to open a user object as a tab page displayed the tab page even if the user object’s
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Visible property was set to false. In the current version, the user object’s Visible property must
be set to true for the tab page to appear.

ImportFile Size Limit
If your application uses the ImportFile method to import very large text files into a
DataWindow or DataStore, ImportFile returns the error code -15.

PowerBuilder versions 10.0 and later are Unicode enabled. Earlier ANSI versions of
PowerBuilder were able to import larger text files.

Note: The release bulletins for earlier versions listed the size limit for large files as
approximately 839,000 lines. However, the size limit depends on the number of columns in the
files, as well as the number of lines.
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Obtaining Help and Additional Information

Use the Sybase Getting Started CD, Product Documentation site, and online help to learn
more about this product release.

• The Getting Started CD (or download) – contains release bulletins and installation guides
in PDF format, and may contain other documents or updated information.

• Product Documentation at http://sybooks.sybase.com/ – is an online version of Sybase
documentation that you can access using a standard Web browser. You can browse
documents online, or download them as PDFs. In addition to product documentation, the
Web site also has links to EBFs/Maintenance, Technical Documents, Case Management,
Solved Cases, Community Forums/Newsgroups, and other resources.

• Online help in the product, if available.

To read or print PDF documents, you need Adobe Acrobat Reader, which is available as a free
download from the Adobe Web site.

Note: A more recent release bulletin, with critical product or document information added
after the product release, may be available from the Product Documentation Web site.

Technical Support
Get support for Sybase products.

If your organization has purchased a support contract for this product, then one or more of
your colleagues is designated as an authorized support contact. If you have any questions, or if
you need assistance during the installation process, ask a designated person to contact Sybase
Technical Support or the Sybase subsidiary in your area.

Downloading Sybase EBFs and Maintenance Reports
Get EBFs and maintenance reports from the Sybase Web site or the SAP® Service
Marketplace (SMP). The location you use depends on how you purchased the product.

• If you purchased the product directly from Sybase or from an authorized Sybase
reseller:

a) Point your Web browser to http://www.sybase.com/support.
b) Select Support > EBFs/Maintenance.
c) If prompted, enter your MySybase user name and password.
d) (Optional) Select a filter, a time frame, or both, and click Go.
e) Select a product.
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Padlock icons indicate that you do not have download authorization for certain EBF/
Maintenance releases because you are not registered as an authorized support contact.
If you have not registered, but have valid information provided by your Sybase
representative or through your support contract, click My Account to add the
“Technical Support Contact” role to your MySybase profile.

f) Click the Info icon to display the EBF/Maintenance report, or click the product
description to download the software.

• If you ordered your Sybase product under an SAP contract:

a) Point your browser to http://service.sap.com/swdc and log in if prompted.
b) Select Search for Software Downloads and enter the name of your product. Click

Search.

Sybase Product and Component Certifications
Certification reports verify Sybase product performance on a particular platform.

To find the latest information about certifications:

• For partner product certifications, go to http://www.sybase.com/detail_list?id=9784
• For platform certifications, go to http://certification.sybase.com/ucr/search.do

Creating a MySybase Profile
MySybase is a free service that allows you to create a personalized view of Sybase Web pages.

1. Go to http://www.sybase.com/mysybase.

2. Click Register Now.

Accessibility Features
Accessibility ensures access to electronic information for all users, including those with
disabilities.

Documentation for Sybase products is available in an HTML version that is designed for
accessibility.

Vision impaired users can navigate through the online document with an adaptive technology
such as a screen reader, or view it with a screen enlarger.

Sybase HTML documentation has been tested for compliance with accessibility requirements
of Section 508 of the U.S Rehabilitation Act. Documents that comply with Section 508
generally also meet non-U.S. accessibility guidelines, such as the World Wide Web
Consortium (W3C) guidelines for Web sites.
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Note: You may need to configure your accessibility tool for optimal use. Some screen readers
pronounce text based on its case; for example, they pronounce ALL UPPERCASE TEXT as
initials, and MixedCase Text as words. You might find it helpful to configure your tool to
announce syntax conventions. Consult the documentation for your tool.

For information about how Sybase supports accessibility, see the Sybase Accessibility site: 
http://www.sybase.com/products/accessibility. The site includes links to information about
Section 508 and W3C standards.

You may find additional information about accessibility features in the product
documentation.

Obtaining Help and Additional Information

Release Bulletin 45

http://www.sybase.com/products/accessibility


Obtaining Help and Additional Information

46 PowerBuilder



Index
D

datatype mapping, PowerBuilder to .NET 33

K

known issues 17

Index

Release Bulletin 47



Index

48 PowerBuilder


	Release Bulletin
	Contents
	Product Summary
	Changed Functionality in This Version
	Known Issues
	Databases
	WPF Window and Menu Painters
	WPF DataWindow
	WPF Controls
	Third-Party and Custom Controls
	WPF Inheritance
	.NET Language Enhancements
	WPF Runtime
	WPF Debugger
	WCF Client Proxy
	Known Issues for the WCF Services
	FlowDirection Property
	Migration
	Installation
	Split Assemblies
	Miscellaneous

	Product Compatibilities
	Third-Party Components and Deployment
	Apache Files
	Microsoft Files
	Oracle (Sun Microsystems) Files
	Software Used for SOAP Clients for Web Services

	Documentation Updates and Clarifications
	EnablePreAuthentication
	SetKeepAlive
	Initdir Parameter Behavior in GetFileOpenName Function
	PowerBuilder .NET Datatype Mapping

	Migration Information
	Migration to PowerBuilder .NET
	Migration to PowerBuilder Classic
	Migrating .NET Targets from Earlier Versions of PowerBuilder
	Migrating EAServer Targets
	Creating an EJB Client Proxy for an EAServer 6.x Component
	Creating a Client Application for an EAServer 6.x EJB Component

	System Types as Variable Names in Proxies
	OLE DB Performance with Microsoft SQL Server
	Change in Behavior of OpenTab
	ImportFile Size Limit


	Obtaining Help and Additional Information
	Technical Support
	Downloading Sybase EBFs and Maintenance Reports
	Sybase Product and Component Certifications
	Creating a MySybase Profile
	Accessibility Features

	Index


